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Вступ

Перетворювальні  системи  являють  собою  важливу
складову  частину  електропостачання  тягових  пристроїв  на
залізниці.  При  розгляді  процесів  динаміки  руху  потягів
перетворювальні  пристрої  спонукають  вирішення  складних
систем  нелінійних  диференціальних  рівнянь.  Прискіпливе
дослідження перетворювальних пристроїв необхідне для оцінки
енергетичних  та  динамічних  характеристик  систем
електропостачання,  а  також  при  розгляді  важливих  проблем
електромагнітної сумісності. Тому вивчання методів розрахунків
перетворювальних пристроїв є важливою частиною повноцінної
технічної  освіти  спеціаліста  в  галузі  залізничного  обладнання.
Саме  ці  обставини  обумовлюють  необхідність  вивчення  даної
дисципліни,  зміст  якої  повинен  бути  невід'ємною  частиною
комплексу знань,  отриманих студентами в процесі  навчання за
означеною спеціальністю.
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Загальні методичні вказівки до виконання робіт

Методичні  вказівки  розраховано  на  виконання  трьох
двогодинних лабораторних робіт. Вони присвячені дослідженню
у  середовищі  Simulink математичних  моделей  RLC ланцюга,
механічних коливань візка електровоза та розв’язуванню системи
лінійних алгебраїчних рівнянь за допомогою сигнальних графів.
Під  час  виконання  лабораторних  робіт  студенти  засвоюють
навички роботи з операційною системою Matlab.

Для  виконання  лабораторних  робіт  академічна  група
розбивається  на  підгрупи  з  2-3  студентів,  які  працюють  на
закріпленому  комп’ютері.  Для  виконання  лабораторної  роботи
студенти вивчають необхідні розділи конспекту лекцій. Керівник
занять  виконує  перевірку  готовності  студентів  до  виконання
лабораторної  роботи  та  дає  дозвіл  на  її  виконання.  Варіанти
індивідуальних завдань для підгрупи видає викладач. Результати
виконання лабораторної роботи затверджує керівник. До складу
звіту  про  виконання  лабораторної  роботи  входять  такі
обов’язкові пункти:
 назва та мета лабораторної роботи;
 результати теоретичних розрахунків;
 графіки, які отримано за допомогою віртуальних установок;
 аналіз отриманих результатів;
 висновки.
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Лабораторна робота 1

ОЗНАЙОМЛЕННЯ З SIMULINK

Мета  роботи:  вивчення  основ  роботи  у  середовищі
Simulink на прикладі створення простих моделей

1.1 Загальні відомості про програму Simulink середовища
Matlab

Simulink  -  це  операційне  середовище  для  імітаційного
моделювання  об’єктів,  робота  яких  описується  за  допомогою
інтегро-диференційних рівнянь. Програма Simulink запускається
до  роботи  за  допомогою  кнопки,  яку  розташовано  на  панелі
інструментів  командного  вікна  пакета  Matlab.  Бібліотека
компонентів,  яка  викликається  за  натисненням кнопки (Library
Browser), містить елементи (блоки) для створення моделі. Вигляд
вікна бібліотеки подано на рисунку 1.1.

1 – панель інструментів з кнопками команд; 2 – вікно коментарів;
3  –  список розділів  бібліотеки;  4  –  список блоків  або розділів
бібліотеки, вказується вміст розділу; 5 – рядок стану, що містить
вказівку по дії; 6 – рядок пошуку блоків

Рисунок1.1  – Зовнішній вигляд оглядача вікна бібліотеки
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Для пошуку необхідного блоку користуються автоматичним
пошуком за назвою. Для цього в рядок пошуку записується назва
або декілька літер з назви блоку та натискається клавіша Enter.
Це  призводить  до  автоматичного  пошуку  компонента  за
вказаною назвою. Якщо блок знайдено, то він відображається в
списку вкладених блоків як обраний. Якщо знайдений блок збігся
у назві, то слід повторно натиснути клавішу Enter.

При  створенні  моделі  в  середовищі  Simulink  необхідно
відкрити файл за допомогою команди (File → New → Model) або
натисненням кнопки (New model). При цьому з'явиться вікно, в
якому  будуємо  модель.  Відкриття  створеної  раніше  моделі
відбувається  за  допомогою команди  (File  → Open).  Створення
нової моделі здійснюється «перетягуванням» необхідного блоку
зі  списку  оглядача  бібліотеки  у  робоче  поле  за  допомогою
курсора (лівою клавішею миші). 

Перед  запуском  моделі  необхідно  встановити  параметри
налаштування  блоків.  Це  виконується  у  вікні  налаштування
параметрів, яке відкривається командою (Simulation → Simulation
Parameters).  У  лівій  частині  вікна  з’являється  список  груп
параметрів,  які  налаштовуються.  Встановлення  параметрів
моделювання  виконується  за  допомогою  панелі  (Solver).
Елементи  цієї  панелі  розділені  на  дві  групи:  Simulation  time
(інтервал  часу  моделювання)  Solver  options  (Параметри
розрахунку).

Інтервал  часу  моделювання  вказується  зазначеннями
початкового (Start time) і кінцевого (Stop time) часу. Як правило,
початковий час дорівнює нулю, а кінцевий час залежить від умов
задачі.

У  параметрах  розрахунку  обираємо  метод  інтегрування
(Type). Це може бути інтегрування з фіксованим кроком (Fixed-
step) або із змінним кроком (Variable-step).  Максимальний крок
інтегрування задається в графі Max Step Size. Також в параметрах
розрахунку необхідно вказати такі методи:

ode45  –  однокроковий  метод  Рунге-Кутта  4-го  і  5-го
порядку;

ode23  –  однокроковий  метод  Рунге-Кутта  2-го  і  3-го
порядку;
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ode113 – багатокроковий метод Адамса-Башворта-Мултона
зі змінним порядком;

ode15s – багатокроковий метод змінного порядку (від 1 до
5), що використовує формули чисельного диференціювання;

ode23s  –  одно  кроковий  метод,  що  використовує
модифіковану формулу Розенброка 2-го порядку;

ode23t – метод трапецій з інтерполяцією;
ode23tb  –  неявний  метод  Рунге-Кутта  на  початку

розв'язання.
Після редагування параметрів  слід  натиснути клавішу OK

або  Apply.  Запуск  розрахунку  (моделювання)  виконується  за
допомогою команди Simulation → Start або натисканням кнопки
на панелі інструментів.

Середовище  може  моделювати  електричні  кола  за
допомогою:

• DC  voltage  source  –  джерело  постійної  напруги.  У
параметрах  змінюють  величину  напруги  (Amplitude),  В
(рисунок 1.2, а);

• AC voltage source – джерело змінної напруги. У параметрах
змінюють амплітуду (Amplitude), В; початкову фазу (Phase), град;
частоту (Frequency), Гц (рисунок 1.2, б);

• Series  RLC  Branch  –  послідовний  RLC  контур.  У
параметрах  змінюють  активний  опір  (Resistance),  Ом;
індуктивність  (Inductance),  Гн;  ємність  (Capacitance),  Ф
(рисунок 1.2,  в). Для отримання одного виду опору необхідно в
елементі  Series  RLC  Branch  виключити  інші  два.  Це
здійснюється,  наприклад:  для  активного  опору  -  «0»,  для
індуктивного  опору  -  «0»,  для  ємнісного  опору  -  «inf»  (англ.
infinity  -  нескінченність).  Для  отримання  двох  послідовно
з'єднаних опорів RL задають таке: R = 10; L = 10; C = inf;

• Ground – заземлення (рисунок 1.2, д, е);
• Voltage measurement – датчик напруги (рисунок 1.2, ж). На

виході  створює  сигнал,  який  дорівнює  різниці  потенціалів  на
вході блоку (між входами «+» і «-»);

• Current measurement – датчик струму (рисунок 1.2,  і). На
виході створює сигнал, який дорівнює силі струму (між входами
«+» і «-»);

• Т-connector  –  лінія  зв'язку  (рисунок  1.2,  к),  яка
використовується для з'єднання виходу зі входом.
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Рисунок 1.2 – Елементи моделювання електричних кіл

На рисунку 1.3 подано приклад моделювання електричного
кола постійного струму, яке містить джерело постійної напруги і
активний опір. Джерело постійної напруги генерує напругу U=10
В,  активний  опір  становить  R=3  Ом.  Час  моделювання  0-2  с;
метод розрахунку ode23s.

Рисунок 1.3 – Модель електричного кола постійного струму

1.2 Вихідні дані для моделювання

Предметом дослідження лабораторної роботи є послідовне з
єднання RLC елементів. Параметри елементів для моделювання
подано в таблиці 1.1.
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Таблиця 1.1 – Параметри елементів схеми

Варіант R, Ом L, Гн C, мкФ Дослідити
1 100 0,1 30 UR(t), I(t)
2 150 0,2 35 UC(t), I(t)
3 140 0,3 40 UL(t), I(t)
4 200 0,4 45 UCR(t), I(t)
5 170 0,5 50 ULR(t), I(t)
6 180 0,1 30 UC(t), I(t)
7 120 0,2 35 UL(t), I(t)
8 110 0,3 40 UCR(t), I(t)
9 190 0,4 50 ULR(t), I(t)

1.3 Порядок виконання роботи

 ознайомитися з описом середовища Simulink;
 скласти модель електричного кола;
 виконати  моделювання  електричного  кола  при

синусоїдальній  напрузі  частотою  ω  =  314  c-1,  з  амплітудою
Um = 10 B.
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Лабораторна робота 2

ДОСЛІДЖЕННЯ КОЛИВАНЬ МЕХАНІЧНОЇ СИСТЕМИ

Мета  роботи:  дослідити  математичну  модель
механічної системи з одним ступенем вільності у середовищі
Simulink.

2.1 Короткі теоретичні відомості

Механічна  система  з  одним ступенем вільності  знайшла
застосування  при  дослідженні  (рисунок  2.1)  вертикальних
коливань  рейкових  екіпажів  з  ресорним  підвішуванням.  До
таких екіпажів належать електровози.

Рисунок 2.1 – Модель візка електровоза

Коливання  маси  описується  такими  диференціальним
рівнянням:

hbhc
dt

dz
b

dt

dz
c

dt

zd
m 11112

2

1  , (2.1)

де m1 – маса кузова, яку приведено до одного візка;
c1 – крутильна жорсткість конструкції;
b1 – демпфування; 
h – збурювальний вплив у вигляді нерівності шляху;
z1 – координати відповідно кузова.

Збурювальний вплив подаємо у такому вигляді:
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     tsinAtsinAth  331 .

Кругову частоту коливань збурювального впливу визначимо
так:

L

V
 ,

де V – швидкість руху; L – довжина рейок.

Для  складання  імітаційної  моделі  потрібні  такі  блоки
Simulink:

 Clock - джерело сигналу моделювання часу;
 Fcn  -  функціональний  блок,  функція  налаштування

якого  задається  в  настроюваннях  блоку  у  рядку  Expression  на
мові  С.  В  запису  функції  можна  використовувати  такі
компоненти:

-  вид  вхідного  сигналу.  Позначається  u,  якщо  він  є
скалярним. Якщо вхідний сигнал - вектор, необхідно вказувати
номер елемента вектора в круглих дужках. Наприклад, «u (1)» і
«u (3)» - перший і третій елементи вхідного вектора;

- константи;
- арифметичні оператори (+ - * /);
- оператори відносини (==! => <> = <=);
- логічні оператори (&& | |!);
- круглі дужки;
-  математичні  функції:  abs,  acos,  asin,  atan,  atan2,  ceil,  cos,

cosh, exp, fabs, floor, hypot, ln, log, log10, pow, power, rem, sgn, sin,
sinh, sqrt, tan, tanh;

-  змінні  з  робочої  області.  Якщо  змінна  робочої  області  є
масивом,  то  її  елементи  повинні  вказуватися  за  допомогою
індексів в круглих дужках.

Derivative – диференцюючий підсилювач (рисунок 2.2, в);
Mux – мультиплексор. Об'єднує сигнали з декількох входів в

один  вихід  (вектор).  У  налаштуваннях  блоку  задають  такі
параметри:  кількість  входів  (Number  of  Inputs),  спосіб
відображення  (Display  option).  В  останньому  параметрі  можна
вибрати  один  з  таких  варіантів:  вертикальний  вузький
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прямокутник чорного кольору (bar), прямокутник з білим фоном і
відображенням міток  вхідних сигналів  (signals),  прямокутник  з
білим фоном без відображення міток вхідних сигналів (none);

 Integrator  –  інтегратор.  У налаштуваннях блоку  необхідно
задати один з параметрів зовнішнього скидання (External reset):

- None - ні (скидання не виконується);
- Rising - наростаючий сигнал (передній фронт сигналу);
- Falling - спадаючий сигнал (задній фронт сигналу);
- Either - наростаючий або спадаючий сигнал;
- Level - не нульовий сигнал.

При  виборі  будь-якого  параметра,  крім  «none»,  на
зображенні  блоку  з'являється  додатковий  керуючий  вхід.  В
настроюваннях  блоку  Integrator  задають  джерело  початкового
значення  вихідного  сигналу  (Initial  condition  source):  зовнішній
(external)  або  внутрішній  (internal).  При  виборі  внутрішнього
джерела  в  настроюваннях  з'явиться  рядок  (Initial  condition),  в
який  необхідно  записати  значення  початкового  значення
вихідного сигналу блоку. Якщо вибрано зовнішнє джерело, то на
зображенні блоку з'являється додатковий вхід, позначений x0. На
цей вхід подають сигнал початкового стану.

 MinMax  Running  Resettable  – визначник  мінімуму  або
максимуму.  Визначає  мінімальне  або  максимальне  значення
вхідного  сигналу  (вхід  «u»).  Вхід  «R»  використовується  для
скидання вихідного значення.

Рисунок 2.2 – Елементи для моделювання
Окрім описаних блоків,  в  роботі  використовуються  також

блоки  Sum,  Gain,  Scope.  Імітаційну  модель  рівнянь  (2.1)  в
середовищі Simulink подано на рисунку 2.3.
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Рисунок 2.3 – Імітаційна модель

У  перший  елемент  Gain  з  назвою  «Omega»  записується
чисельне  значення  частоти  збурення.  У  блок  Fcn  необхідно
записати рівняння нерівності. Вигляд вікна налаштування блоку
Fcn  подано на  рисунку 2.4.  Після  побудови імітаційної  моделі
задаємо  параметри  для  розрахунку:  час  моделювання  0-10  С;
метод розрахунку ode45. 

Рисунок 2.4 – Настроювання елемента Fcn
2.2 Завдання для розрахунків

Варіанти  індивідуальних  завдань  для  моделювання
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коливань електровоза бригадою студентів подано в таблиці 2.1.
Дані  цієї  таблиці  використовуються  для  задання  параметрів
окремих  модулів  імітаційної  моделі.  Час  розрахунку  прийняти
0-10 С, метод розрахунку ode45.

Таблиця 2.1 – Варіанти для індивідуального завдання

Варіант m1, т с1, кН/м b1, c/м
1 16 3000 100
2 18 2900 105
3 20 2800 110
4 22 2700 115
5 24 2600 120
6 26 2500 125
7 28 2400 130
8 30 2300 135

2.3 Порядок виконання роботи

 ознайомитися з описом середовища Simulink;
 скласти імітаційну модель;
 виконати моделювання;
 змінюючи  швидкість  руху  електровоза,  заповнити

таблицю 2.2;
 побудувати графік.


Таблиця 2.2 - Залежність амплітуди коливань від швидкості руху

V, м/с 10 15 20 30 40 60 80 90 100
А, мм
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Лабораторна робота 3

РОЗВ’ЯЗУВАННЯ СИСТЕМИ АЛГЕБРАЇЧНИХ
РІВНЯНЬ ЗА ДОПОМОГОЮ SIMULINK

Мета  роботи:  розрахувати  системи  лінійних
алгебраїчних рівнянь в середовищі Simulink.

3.1 Короткі теоретичні відомості

Функціонування  складних  об’єктів  описується  системою
інтегро-диференційних  рівнянь.  За  допомогою  перетворення
Лапласа її можна подати у вигляді системи алгебраїчних рівнянь.
Для розв’язування системи лінійних алгебраїчних рівнянь можна
застосувати  сигнальні  графи.  Перелічимо  основні  способи
подання системи лінійних алгебраїчних рівнянь у вигляді графів.

Розглянемо  не  вироджену  систему  лінійних  алгебраїчних
рівнянь













.

,

,

3333232131

2323222121

1313212111

bxaxaxa

bxaxaxa

bxaxaxa

Введемо  фіктивну змінну  x4.  Запишемо систему  в  такому
вигляді:













.0

,0

,0

43333232131

42323222121

41313212111

xbxaxaxa

xbxaxaxa

xbxaxaxa

Складемо граф Коутса (рисунок 3.1).
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Рисунок 3.1 – Граф Коутса

Перепишемо систему таким чином

 
 

 











.1

,,1

,1

433332321313

423232221212

413132121111

xbxaxaxax

xbxaxaxax

xbxaxaxax

Складемо сигнальний граф Мейсона (рисунок 3.2).
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Рисунок 3.2 – Сигнальний граф Мейсона

Розглянемо  методи  моделювання  сигнальних  графів  у
середовищі  Simulink.  У  S-моделі  вершину  фіктивної  змінної
(витік) подаємо блоком «Consntant», інші вершини графа подаємо
блоками «Sum». Ваги дуг задаємо за допомогою перетворювачів
«Gain», зі змінним коефіцієнтом посилення. Для спостереження
результатів розрахунку системи використовуємо блоки «Display».
Зовнішній вигляд описаних блоків вказано на рисунку 3.3.

Рисунок 3.3 – Блоки Simulink
3.2 Приклад розв’язання системи алгебраїчних рівнянь

Нехай задано таку систему рівнянь:
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











.1735

,5522

,22

321

321

321

xxx

xxx

xxx

Перетворюємо систему до такого вигляду:













.1835

,5532

,222

43213

43212

43211

xxxxx

xxxxx

xxxxx

Імітаційна модель у середовищі  Simulink,  яку створено за
допомогою сигнального графа Мейсона, подано на рисунку 3.4.

Рисунок 3.4 – S-модель сигнального графа Мейсона

3.3 Порядок виконання роботи

 виконати перетворення системи рівнянь;
 скласти імітаційну модель;
 виконати моделювання.
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3.4 Індивідуальні завдання

Таблиця 3.1 – Індивідуальні завдання

Варіант Завдання Варіант Завдання

1













802

225642

13844

321

321

321

xxx

xxx

xxx 2













1832

22552

95

321

21

32

xxx

xx

xx

3













1102

200351

162243

32

321

321

xx

xxx

xxx 4













10024

10023

16544

321

321

321

xxx

xxx

xxx

5














200332

25554

18043

321

321

21

xxx

xxx

xx 6













852

29562

1307

321

32

321

xxx

xx

xxx

7













544353

31542

2002

321

321

321

xxx

xxx

xxx 8














1202

30545

12522

321

321

21

xxx

xxx

xx

9













109

30523

47062

32

321

321

xx

xxx

xxx 10













806

18527

185553

21

321

321

xx

xxx

xxx
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